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Detail Overviews

KPT Menu >
KPT Style Setup...

This plug-in allows changing the user-interface (‘U-I') style on the fly (This is very unusual)

The general controls are shown in the current style. All available HUB files containing the U-I elements (shared by all filters,
therefore “Hub”) are scanned automatically and presented in a hierarchical pop-up menu. In the first release this includes a 24
bit style with turquoise green/orange and a plain restrained text objects GRAY style. Both are very nice. More to come by
Comdex. Drop in update.

Also settable is “pre-lighting” a cute feature where the buttons and balls light up when you get close to them. Slightly ahead of
the Mac guidelines, so for purists, here you can turn it off...

This acts like a “Central Preferences” spot for all other filters with a dialog.

KPT 3-D Stereo Noise

A very unusual plug-in! A researcher at Bell Labs discovered a
method to create a special dithered noise where certain point
will be seen by both eyes as if they converge on a plane. We
have written a filter that creates this effect by processing any
Photoshop image! The result is a single bit black and white
noise, which has incredible stereo 3-D depth properties, which
can be seen without any glasses! You would swear there is a
one inch deep hole in your monitor with certain figures or letters
or circles popping out at you an inch or more! An exact
description of how to help focusing will be provided in the Help
for this filter. Printed versions have been shown with great
response in OMNI and GAMES Magazines. It's a specialized
interest of course and a small percentage of people cannot
perceive the depth effect at all. Still, it will amuse the majority
and drive some of them completely bonkers.

It has that great “hey-Fred-come-here-look-what-cool-thing-I-got
1 effect.

An example image can be found up here in the New Files area

KPT Gradient Designer...

This is one of the central showpieces of the collection and the
largest one to date. Also the first one with the embedded expert
mode level.

Photoshop 2.01 has a gradient tool which generates blends

between two colors, in two styles and global opacity. We go

further by far: Features:

* Up to 512 color gradients (many more colors, much easier)



* New gradient algorithms (more styles, new effects)

» Looping control (new possibilities)

* Real-time momentary pop-up 24 bit color picker (faster)

» Blended Transparency (much easier)

» Presets with Hierarchical Families (more, faster & easier)
* HUB file user interface (full 24 bit, switchable styles, fun)
« KPT user-interface design (more coolness)

» Gradient Presets used by other KPT filters (universal lego
block tool)

« Expert mode installable module (more power):

« 8 different Color picker color spectra, including

» Metallics and pastels, CMYK legal gamut, etc...

 RGB and Opacity number display

» Translucency as independent Alpha Channel Overlay in%

Basics:

There is really only one Gradient rule:

Click anywhere inside the blend and the color you assigned to
that spot will be smoothly interpolated to the sides. That's it.

There is always some gradient there already, of course, and you
can quite easily try any of the presets. In fact you will find a
variety of samples there that give you a good idea of the
possibilities. (There are LOTS... this thing is much deeper than it
may seem at first glance!)

To assign a color simply click and hold the mouse button down;
the color picker will pop up right below. Now you can drag the
cursor to any color there, or indeed even to any spot on the
screen and release: voila you ‘sucked up’ the color at that pixel.
(Details on the color picker below.)

How to make a simple gradient:

Click and hold on the far left side of the blend, drag to the color
you like and release, e.g. “red”. Now repeat on the far right side
of the blend with e.g. “yellow”. You instantly get 500 shades of
smooth orange in-between.



(Note: this is not 500 pixels “resolution”, since the Gradient will
be applied and scaled to ANY size and resolution. It means that
there are up to 500 possible separate colors in the gradient.)

How to add a third color:

After you first set the left and right edges the way you like them,
you can now add another color anywhere in the middle by click-
drag-to-color-release. It will interpolate smoothly to the side
colors, e.g. ‘red’ to ‘white’ to ‘yellow’.

How to add even more colors:

That's where the little ‘bracket’ immediately above the blend is
coming into play. ( the horizontal ‘{*) Initially it spans the
entire width and includes everything (and you can always reset
it to that by double clicking the center).

But, you can also drag the sides left and right to resize it and
then drag it around as well. Lets say you set it to span across
just the middle third...: the same simple rule applies just as
before, but now it applies only to that middle third area!

This way you can make lots of short little blends and create
composite long multi colored complicated ones, as you will find
in the presets.

In fact with this one rule and one tool you can create pretty
much anything anybody could want in a blend....

How to add transparency:

In the color picker on the upper left there is a field with the word
“Transparency”. If you release in that area, you are assigning it
just as if it were a color! Could it be any easier?

To make a blend from “Red” to “Nothing” (very complicated
currently in Photoshop) you merely put Red at the left edge and
Transparent at the right. It will smoothly fade out the Red and
get more and more transparent, all the way to no color at all at
the far right.

In order to see the gradual opacity changes, the gradient is
drawn over a checkerboard test pattern, which gives a quick
and accurate overview of which parts of the gradient let some
percentage of the underneath be seen. When applying the filter



by clicking on the Ok button, there is of course no checkerboard
pattern, but the previous image in the original Photoshop
window will be visible to some degree.

Note that as you can pick up a color from anywhere on the
screen you can also pick up transparency from anywhere in the
picker(!) So if you see a half opaque area you can pick that up
for any other spot.

How to get ‘hard’ color transitions:

If you move the bracket edges inside the blend and then assign
a color right at either edge the rule will still apply as expected:
interpolate between the brackets. It will not affect the colors
outside the brackets at all. This means that adding a new color
right at the left edge will create a smooth blend from the new
color toward the right, but a hard transition to the color
immediately to the left of that bracket edge. Try it....

How to soften ‘hard’ color transitions:

Make the smallest possible bracket (about a quarter inch) and
position it over a hard edge. Then click and release right at that
spot. It will pick up the color of the pixel right there and smooth it
to the bracket edges.

More about the Color Picker:

When you click and hold the mouse button while inside the
gradient strip, the color picker pops up momentarily right below.
You can simply drag to a color (or an action, such as launching
the Apple color picker for those poor addicted folks or the
logically handicapped).

With this click-drag-release motion a 24 bit color is chosen in
about a half second. Really, try it a few times and it gets to be
extremely easy. (If your mouse is set to ‘ultra fast’, it might be a
little harder to move to exact points : adjust your mouse)

The spectrum strip has all the hues of the RGB/HSV spectrum
in the center at full saturation, so you should have no trouble
dragging to a 255,0,0 Red or a 0,0,255 Blue very quickly. Above



each full shade “white” gets mixed in, below “black” gets mixed
in, so you have about 40 shades of varying intensity right there
as well.

By the way, this is an editable image in the HUB file! You can go
in with ResEdit and replace or edit it, if you prefer other shades,
more pastels, wider range for dark ones, funny spot colors,

Note that the cursor can travel anywhere on the entire screen to
capture a shade! The color picker purposely does not obliterate
the gradient itself, so if you see a color you want inside the
blend, it's there for the picking. As mentioned above that
includes the translucency percentage: if you pick up a shade
over the checkerboard pattern you will get its opacity
percentage!



Below the color spectrum is a grayscale range from 0 to 255 for
instant selection (compare that to getting a medium dark gray
with the Apple picker...!).

Important Note: Please take a second to check whether that
looks like a linear range to you, or whether you have an inch or
more of black on the left. Those should be dark shades of gray!
You need to adjust your Gamma then.

Go to Photoshop’s File > Preferences > Monitor Setup and find
your monitor, set the lighting and play with Gamma settings of
1.9 and up. You need to reboot for it to take effect. A totally
linear gamma will often render everything way too dark or non
linear. All darker grays will be near black.

This adjustment is one of the most important steps you can take
to get color fidelity. You also deceive yourself otherwise and on
any other machine your own images will not look as you created
and intended them ! Please do it...

At the far right of the picker is a rectangle giving you access to
the Apple and Photoshop color pickers, at the left an option to
cancel the color select operation and one more key option
“Translucent” is a choice just as if it were another color (!) and
will follow the blend rules exactly as expected. See above...

More about the Gradient Styles

There are several options that change the method with which
the current gradient will be applied to a region. The three boxes
in the top center will show at a glance what the settings are at
any one time. To change the settings, click and hold; a pop-up
menu will show all available alternatives, drag to your choice
and it will be ‘installed’.

The leftmost box is showing the current style by actually
rendering a small example gradient into the box, rather than
displaying an icon (!).

Click-hold will display the pop-up menu with a set of choices
(more probably to be added soon). First there is the plain
directional gradient, second the sunburst one. These have



always been part of the Photoshop blend tool dialog.

New styles are the radial sweep style, which is like a clock hand
drawing 360 degrees, or like a Radar screen sweep. This one
can generate some pretty amazing new blends, in particular the
metallic gradients work extremely well with this style. The last
for now is a rectangular inset blend, used often in the partially
transparent ‘frame’ effects.

The next box is displaying the repeat mode or ‘loop’ control.
There are initially two options here: starting the gradient at the
leftmost color and executing the gradient style to the rightmost
color exactly once.

The second loop mode would do the very same sweep, but then
revert back to the first color creating a smooth ‘loop’.

One can also visualize this latter one as a Triangle curve going
from Bottom to Top and back to the Bottom again, whereas the
first mode is a Sawtooth going from Bottom to Top and starting
at the Bottom again, hence the icons...

There are distinctly different effects that can be created with this
mode control. For instant the sunburst (old ‘radial’) blend can be
a ball or a doughnut shape! The radial sweep style creates
symmetrical color blends and ‘nipple’ like center shapes. (Try
twirling such a shape!)

The third box is a controller for the directional styles. Simply
click inside and a vector will be drawn at that angle and then be
applied to the directional and radial sweep styles.

More about the Presets

The “Presets” mechanism is rather obvious. Click on the ADD
button to add the current blend and you get a dialog where you
can name it or cancel. Press the DEL button to delete the
preset currently shown.

They are saved in their own central file called Gradients HUB,
which can be accessed by all other KPT filters which are able to
use Gradients !

This is a very important part of the design, making gradients not
only an ad-hoc tool to be applied to a selection on the spot, but



also a general resource usable for other purposes.

One example is for instance the Julia Set Explorer, which will
use these complex 24 bit gradients to “wrap around” Julia and
other fractals, even employing different blends for the interior
and exterior of the set!

The saving is done with hierarchical families since there would
be far too many for a linear menu and to provide separate
menus for each of the categories of use: transparent blends,
Julia blends, special effects, etc...

Note that you can make your own categories as well, such as
saving all your own concoctions in “Bobs Weird Blends”....



One main thing to realize is that you are in PHOTOSHOP, for
god sakes. There are zillions of ways to modify these things.
Think of them as mere starting points that beg to be further
processed. Try Embossing, Find Edges, Adjust Curves, Levels,
Diffusion, Arbitrary Maps, Hue changes, Sharpen, Distorts,
blablabla.....!

KPT Gradient on Paths...

One of the most powerful and complex plug-ins, creating image
effects that literally have been impossible to do with traditional
methods! lllustrating the interconnectivity and “lego block”
structure, the GP subscribes to the presets in the Gradient
Designer GD, in fact it uses TWO blends, one for color and one
as an alpha channel to fade in and out and blend with the
original image in any Photoshop window.

Whereas the standard GD applies the blend in one of the 16
combinations of algorithm and repeat loop mode, the GP can
“wrap” any blend extremely smoothly around a free form user
path, drawn with the lasso or other marquee tools. (Limitations
in the filter interface by Adobe do not allow a full freeform path
tool by ourselves). One can for instance draw an ellipse and
feather it to be 100 pixels wide then the smooth 24 bit blend will
be applied perpendicular across, following the elliptical path and
including local opacity and blending effects. This creates glows
and halos and rainbows and metallic tubes and lasers and fogs
and on and on, the likes of which would often be literally
impossible without.

A preview window shows a feathered path varying in width and
any settings are immediately applied. The gradients subscribed
are shown as full color strips and selected from named
hierarchical popup menus. Looping controls are available
separately for color and alpha blend.

Four degrees of post processed blurring are added, as well as
three very powerful apply algorithms that create a procedural
blend melding the effect into the current image. Hard to
describe, highly unusual, incredibly powerful. Beta users of the
Gradient Designer almost fainted at the idea of a GP...



Images using GP effects have confounded any Photoshop
experts to date.

KPT Julia Set Explorer...

Another major centerpiece of the collection. Not a filter but a
fractal creator and at the same time a fractal explorer. There
are a total of four at this point, but they will ultimately converge
into one very large one with an expert mode level allowing for
the other 3 and many more.

Very brief background: The Mandelbrot fractal has been well
explored in many programs, deep zooms Yyielding interesting
pictures. We go much further in every respect.

The idea is that for those that have not played with fractals, this
will be a very enjoyable almost game-like exploration of the
space. Those that are into fractals will welcome the easy
interface and to have it right inside Photoshop, so the output
can be manipulated with all those tools right away. Even those
that are total power fractal hounds and some are even burned
out on them will come around, since this offers features which
can create variations never before seen. We will submit some
of the new algorithms to the world’s foremost fractal ‘pope’
Heinz Peitgen from the University of Bremen as worthy for
inclusion in the standard literature.

We commend our programming staff for pushing the envelope in
an area of pretty obscure, complex math.

In particular: for every point on the Mandelbrot set there exists a
4 dimensional space called the Julia domain. Rarer and harder
than the basic set. We show it in a very direct user interface: a
preview window, click on a spot and it zooms in/out with user
stepsize, range about 100 million:1. Then we provide access
the variables involved and recompute on the fly.

Innovations : first and foremost: we subscribe lego block style
to the Gradient Designer blends including the opacity alpha
channel. We then wrap the 24 bit blends around the Julia set,



with  full control over looping, repeat count and totally
unprecedented spiral angle settings. This yields images which
are unlike any previous fractal program (all of them derive color
by simply computing the color wheel spectrum, most of them
even only in 8 bits with so called dwell bands, none of them with
local alpha channel control over transparency). We also added
an unusual interface: a ‘data picker’ analogous to the color
picker. a momentary popup with a slider control. Instead of
typing in new values and switch from mouse to keyboard and
back, this allows you to click on a number drag and release in
abut a second...The slider has 400 steps resolution and then
features a secondary full Vernier scale for each point,
essentially creating a 160,000 step resolution slider!!

There is also a 360 degree continuous panning controller, zoom
direct and centered controls, user stepsize settings etc.

Render speed for 24 bit Julia sets is amazingly fast. The
preview is generated with iteration so a rough idea is visible in
about 1/4th second and repeat clicks pre-empt the computation.
This allows extremely fast exploration of the space. Color
choices are instantly mapped into the set.

It comes with about 20 presets, many looking absolutely unlike
any previous published fractal images.



This is not for everyone, but will earn us major Kudos in some
circles and be a pleasant diversion for almost all. Having it as a
plugin for Photoshop allows using it as a source for non fractal
like backgrounds, blends and textures, as well as taking
advantage of PS for very powerful post processing.

KPT Julia Type II Explorer...

The 3 other plugins dealing with fractals are essentially de-
coupled stand alone versions of the expert mode for one central
BIG fractal explorer. For now they are independent filters with
their own user interface, chiefly to allow independent presets for
each as well as circumventing size limitations in the filter code
structure.

Type Il features a faster version of the Julia set with two less
variables, but a modified central formula which explores a
different 4-D space. Comes with about a dozen presets.

KPT Julia Type III Explorer...

See above. Type |ll features especially an unusual new
algorithm which yields asymmetrical fractals and a very linear
depth self similarity. One can find triplets of set features and
zoom dozens of millions of times deeper and find an equally
complex substructure. Fractal fans will find this very intriguing.

KPT Mandelbrot Set Explorer...

See above. This one is a decoupled version exploring
specifically the ‘classic’ Mandelbrot set. This allows users to
search for well know features, published set locations and or
compare to images they may have generated in other programs.
In fact, recreating a ‘known’ Mandel area and then using our 24
bit gradient technology with local variance translucency will
surprise even the most jaded Mandelbrother

For example, subscribing to a Gold highlight blend from the
Metallic preset family can render classic Mandelbrot areas as if
cast in liquid gold...

KPT PixelStorm



A very interesting filter, called the “Atomizer” by Russell Brown
of Adobe. In principle it is a super diffusion displacement
process, taking each pixel on the screen and in a controlled
random fashion disperse it over the current selection area,
including feathering proportionately. It also include a Darkening
apply transfer mode. The result is a totally dispersed image
resembling spatial noise, or particle systems graphics code. In
fact repeated application in small areas can suck in neighboring
colors and intensity and dissolve them in a veritable PixelStorm,
hence the name.

It iIs an example of a process with which certain effects are
suddenly completely trivial, and without which these effects
would be downright impossible. Sign of a good tool!

Certain Beta testers went absolutely nuts over this. In early tests
images of a woman’s face get torn into depthy wind storm like
turbulence with raw features and colors remaining. Using Paste
Controls, opacity, blends and blurs a whole array of new
Photoshop effects are born.

It may be a tiny little filter and look like utter chaos if applied
indiscriminately across an entire image, but in the hands of a
skilled artist it becomes a subtle means to an aesthetic end.
This trio of filters stem from one central code which may in the
future become additionally a full dialog Diffusion/Scatter
Explorer/Designer module.

KPT PixelWind

There are three settings and transfer modes decoupled into
stand alone momentary filters.

If Storm is at a 200 pixel size, Wind may operate at around 80,
but also feature a different apply mode. So 2-3 times PixelWind
iIs NOT identical to 1 PixelStorm...

KPT PixelBreeze

In relation to PixelWind, this one is set at around 30 and
features yet another combination of transfer/apply modes, so a
repeated PixelBreeze does not add up to a Pixelwind.

This makes this a value added real set of three, rather than a
single numerical setting. Each one has a unique character in
repeated application and will yield subtle different effects.



KPT Texture Explorer...
This may very well be the crowning center piece of the Version
1.0 collection.

Textures have become a staple component in graphic arts
creation and really the term denotes the entire sweeping notion
of “filling a shape with something more than a simple flat color”.
As technology has progressed it indeed became standard
practice to embellish components with more than trivial color.
Scanned marble, wood and stone has become such common
fare as backgrounds that there is hardly a cheap commercial left
that does not have a slab of something in the background.
Collections of more scans, CD ROMs etc, have appeared some
at extra-ordinary prices stemming from stock photo license
agreements (one such set is $70 per picture or $4,000 for a set
of CDs!)

While there is and always will be a place for natural high
resolution scans of actual objects, the Texture Explorer is
bringing a whole new game into this.



It is immensely useful to have the texture generation right within
Photoshop. It can render any of them right into the current
window, selection, or feathered selection and then be instantly
able to use the whole arsenal of Photoshop tools to further
process them...

And while the possible ‘space’ of textures is absolutely gigantic
and does include a variety of naturalistic components such as
woods, marbles, minerals, cloth, clouds, etc. it opens the door
to a much larger space of the kinds of things not seen before,
plasma and fire and luminous blobs and alien hieroglyphs,
textures that are simply not scanable since they plain do not
exist!

Escaping the current envelope and coming up with an image of
truly NEW and unique quality is indeed a rare thing to behold!

A little background: The Texture Explorer generates completely
algorithmic mathematical output, there are no picts or scans
involved at all.  Moreover it can apply the effect as infinite
seamless tiles, morph the inside while remaining seamless or
scale the algorithm to stretch the texture to any size and
resolution! As the final coup de grace it has new methods of
applying the effect to the existing image resulting in very
complex unprecedented blends, “wrapping the texture around”
existing images, following highlight and shadows and modifying
the texture on a pixel by pixel basis as the apply process
unravels. This is sure to cause a lot of excitement with users,
because many of the effects would simply be impossible to
achieve by traditional methods!

While the engine and power of the Texture Explorer is re-
defining the genre, all this power would be useless if it were not
coupled to the ingenious and friendly user-interface controls.
This is where the TE complete leaves any comparison with
other products of any kind and stands alone.

To explain this another way: inside the heart there are very
complex math routines involving dozens and possibly in the
future hundreds of variables and parameters and interactions.



You will find references to waves, frequency, correlators,
diffusion, distortions, stretch, squeeze, overlays, blends, multi
layer combinations, twirliness and bumpiness, scale factors and
constants, a dozen color control variables and looping, repeat,
transfer modes, gradient indices, multiple alpha channels etc etc
etc. (and we can invisibly extend this vocabulary any time..).
With any previous software that even remotely attempted this
kind of effect you would have faced a gigantic cockpit full of
dials and knobs, at least dozens even in V1.0 and worse later.
Not only is that in itself a problematic thing to create, document,
teach and master, there is a more fundamental problem: to
achieve any particular kind of effect, be it a marble or a magma
blob, you have to have a cognitive understanding of how the
parameters work and affect each other and the skill and
patience to set all controls in that direction. And that is the hitch:
there is a definitive limit to how such a casual or novice user
could absorb and learn, as well as a physical limit to how many
sliders you can fit in a dialog or move up and down to hunt for
something! We know this first hand, because that is exactly
how early Alpha versions were proceeding to be built and the
frustration factor grew exponentially with every new set of
features.

Enter the mutation metaphor and its implementation here!
Presented in the center of a preview box is the current texture,
shown in a generous 10,000 pixel size.

Now: think of each parameter and variable as a “gene”
contributing to the final result. If we vary 1% of the genes in say
100 parameters that means in every generation 1 number will
have changed randomly, or :"mutated”. In the TE this will
create a series of small derivative textures shown in quarter size
arranged as 12 smaller rectangles around the center current
one.

It turns out this is really the only control necessary for the entire
process (with one special case of ‘color’ genes decoupled as an
extra feature) and we show this in a series of control points you
can click on, little balls, the lowest of which is partially in the
ground and then they rise higher and higher toward an abstract
“mutation rate” of 100%. Lets’ click on the ‘highest’ point which



equals 100% mutation.

Every time now that the TE creates a derivative ‘cousin’ of the
current texture it will vary EVERY parameter by some random
amount. The result: in one cycle you get 12 new textures that
bear very little resemblance to the current center one.

What this is really doing out side the mutation metaphor is to
show you random examples of what is possible, spread
throughout the gigantic universe of possibilities. You get to see
in random areas of the potential space what -certain
combinations can look like.

Back to the exploration: lets say the 9th one looks kind of
intriguing, click on it and POP, it becomes your new chosen
current texture, now drawn in full size in the center. And before
you can say WOW it starts the mutation cycle anew! Not only
did you get the one you wanted, you get 12 cousins right with
it...!

Now in that cycle the 11th one is neat, click, switch, redraw,
mutate...!

You get to traverse the space and sample the results every time
you click and since the redraw is interleaved, you can even do
this in mid cycle, trying out new ones just about every second if
you like!

So now lets say you really have become interested in the 3rd
one and you don't want it to keep generating these wild
mutations where every cycle looks totally unrelated to the
previous. Simply reduce the



mutation rate and click on a lower ball...roughly in percent it will
go down and you reduce “how different is each cousin”, so you
are slowly converging iteratively on your favorite texture...

On the second ball you are now mutating minute changes from
one to the next, so if you had an orange magma blob, each
cycle shows you 12 other magma like blobby variations.

And so you hone in on what you see. At any time you can say ‘I
like it! SAVE it” and save just the algorithm definition in a few
hundred bytes !!

To really emphasize the revolutionary nature of this process:
You are ending up seeing dozens and maybe hundreds of
examples of the potential space of possibilities and what you
finally end up with and call “my happy magma blob” is
something where you don’t know quite what it is or even why
you like it and most certainly you would not have the foggiest
idea on how to create it from scratch!! And given the ridiculous
multiplication effect of the variables, it may even be
IMPOSSIBLE to ever re-create it even if we gave you each
slider one by one! Its very much like the move in a chess game
increasing the possible space of potential game progress, so
that after 50 moves you have come to a particular situation that
may well have never been seen before or is likely to ever be
played again!

We don’t want to make any ludicrous claims of “1 billion textures
shipped!”, and there is bound to be a large amount of
duplication and overlap and non sensical combinations, the
point is though that the vehicle of exploring the space allowed
you to avoid all the dead ends by choosing preferred states at
every cycle!

In fact, the Texture Explorer is shipped with nearly 200 presets
(and you can double that in a day!) and during the development
and preset creation there were amazing incidents of certain
unbelievable combinations that indeed have never been seen
again! We have dumped certain preset generations under the
impression that updated further Betas would make it easier to



redo them and much to our amazement the space has grown to
be SO large that we literally cannot recall certain gems of
beauty!

This is not to say that this thing is anywhere near from being
finished at the 1.0 stage. It will not yet grow a wall size marble
with fine veins over lacquered mahogany, but | think the key
word is “YET”

On a practical note:

Play with the presets and use the maybe the 3rd lowest
“mutation ball” to see instant derivatives of each preset. That
alone ought to be very educational since many totally
unexpected things can happen.

The single color ball has a special decoupled mutation

function: it will keep all parameters of the texture frozen and
simply change which colors are used. NEAT!
| have not explicitly mentioned this so afar, but it ought to be
obvious: the TE subscribes to the endless array of Gradients
that are available from the Gradient Designer! It means Lego
blockness to the hilt!
If you go in the GD and make a puce-mauve-off-lilac-lime blend
it will sooner or later show up in the TE and totally redefine what
happens to the exact same textures you just saved. Multiply the
possibilities by ‘n’ again.

In fact, clicking on the color ball does not LOOK like the
variables remain unchanged, because simply the way the blend
Is designed can have such incredible effects on the outcome!! If
a blend is all black and has a little soft orange ridge at step 400-
410 you will highlight a certain subrange in the texture and get
certain orange swirls over black. Now if you change that in the
GD from 300-320 you will see a totally different texture, possibly
looking NOTHING like the same one with the previous blend...

The suggested way is to browse the larger space with the high
entropy ball settings and when you get to a fun area move to the
lower balls.... just as if you fly through galaxies and then find a
solar system and then throttle down to earth and then further
down to the North Pole.... And just when you are convinced this
is a pretty white and cold texture-planet suddenly you will



mutate to deep Africa and your socks melt.

Incidentally: if you click on the center texture itself you are
seeing another reason for the vastness: now without changing a
single gene or color all you are doing is to re-seed the starting
values of all our stochastics (read “ random generators”) and
that means its like buying a huge wallpaper of a texture and you
see an inch section at a time. With every click in the center, just
for THAT texture, you are looking at a new section of the
wallpaper. You can do that 16 million times without repeating.
OUCH.

The third clincher in the triumvirate of amazement is the way
the Texture Explorer APPLIES the textures to the Photoshop
window. As alluded to earlier, there are various transfer mode,
including the most revolutionary one called “Procedural Blend”.
To see that in action you need something with shades, you may
have seen it applied to faces and the like...

IN fact, caveat: if the procedural blend option is on and you start
with a plain white new window, you will not see
ANYTHING....just like you wouldn’t if you had picked Blur More
or Twirl...

The exact mechanics of the new Blend mode are a little
involved, but suffice it to say that even with an understanding of
the technical insides the results are so amazing and new every
time we tried it that | have almost given up on trying to
understand it! Certainly to predict it...

You should realize that you can overlay multiple layers with
GREAT results, try choosing complementary color schemes and
complexity. OR slightly mutate a texture and then use a darken
only second layer, adding depth shadows and get bump map
like effects. The sky is the limit!



Large feathered selections work well...consider using a
selection with one texture then the Select > INVERSE area with
another...

Try a Texture in individual channels, like R/G/B or just the hue
channel for instance.

Or do it to a floating selection (command-c then command -v
your selection) and then use paste controls for even more apply
options...

Ask your 3-D render applications to bundle this right inside
their apps and spit out native format textures right into the
apps.. Wrapped around objects and raytraced these things are
phenomenal!! You may never use a scanned anything for that
again!

Contact me on AOL with ideas for other variables and
extensions. We always listen.

Worst case: we already thought of it and dismissed it.

Best case: we already thought of it and its in there.

Blur Menu >
KPT Smudge Darken Left
These Smudge filters are two sets of symmetrical decoupled
standalone. There may be a full dialog Smudge Effects filter in
the future. It essentially is a single sided horizontal Motion blur
or the manual smudge tool applied repeatedly in vertical strips:
It will take the current selection (try all these on small
rectangular selections first..., then feathered ones etc) and
repeatedly apply 6 displaced copies with a transfer mode,
resulting in a 6 layer blurry blend. It is entirely unlike the Motion
Blur, in that the latter extends in both directions and has no
apply mode per se. It is also totally unlike the normal and
Gaussian blur in that it is constrained to horizontal features not
cell based, and again utilizes the apply mode.
Its a very simple plain tool, yet comes in very handy, just like the
exact size wrench can do...
Subtle trailing motion and wind effects are easy, but also
interesting alterations of textures for further complexity. It acts
as a true complement to any of the built-in tools.




The Darken version will slowly build up the dark content in the
selection, after about 4-6 repeat apply converge on black.
Particularly interesting seem to be Black speckled noise details
on a light background: here the darken creates smooth trails
away from the dot resulting after repeat applies in needle-like
structures emanating from the initial dots, quite unlike anything
normal PS tools would produce.

As implemented here it cannot be achieved in a simple cell
based convolution kernel, as many other blurs can. This one is
truly an extension of the arsenal. Don’t underestimate the little
ones..it is easy to look at the minuscule code size and dismiss
them.

KPT Smudge Darken Right

Complement to the left version. Note that a Right after a Left
Smudge will NOT recreate the original image. In the multi layer
process information is irretrievably lost. Consider it a donation to
Entropy.

Also, to achieve 4 variations on these you can rotate 90 degrees
and apply, giving perpendicular vertical smudge once you rotate
back.

KPT Smudge Lighten Left

Complementary to above using a Lighten transfer mode. The
combination of darken and lighten can be very effective.

KPT Smudge Lighten Right

Complementary to above

Also consider making macros of multiple
applications/combinations of the four. Neat!

Distort Menu >

KPT Glass Lens Bright

This a very popular little filter exemplifying incremental advance
over the standard functions of Photoshop. There is a standard
filter called “Spherize” which will take a selection and ‘bump’ it
outward to the front. The KPT version though progresses far
beyond that: it is actually a special case ray tracer from a
straight on view, complete with movable, shadow casting 3-D
light source and ambient light!

The resulting sphere will look very much more like a 3-D




rendered ball and features anti aliasing options.

There are three momentary decoupled versions. Bright will have
a low ambiance setting, medium aliasing and high intensity
spotlight, casting a ‘hot’ spot. To make repeat apply of multiple
spheres easier and vary the ‘sun’ position in a real 3-D arc we
implemented a 9 position control via the numeric keypad!

Simply hold down the “7” key to have the light shine from the
upper left and a shadow on the lower right and the “2” key to
shine from bottom center. Very easy.

In fact you can even use the command-"f” repeat filter function
and vary the light position with every new apply! To make
multiple identical spheres, it is suggested to hold down the
option and command key and click-drag the selection away to a
new position. Then command-f to recalculate the object.
Interesting results can be obtained with large areas that are
feathered at high settings...you can then also drag away the
feathered selection leaving a glow in the background color. Very
powerful!

KPT Glass Lens Normal

The normal setting features user controlled 9 position 3-D lights
as well, but the intensity of the light is reduced to about 60%,
resulting in less harsh lighting and contrast. Smooth spheres
with small highlights



and soft shadows can be created easily. A very nice
combination is a sphere with a bright highlight via the “2”
position and then a ‘Normal” one over that with the “7” position.
This will act like extremely complex multiple light source
renderings, diffuse spots, ambient shadows... Even though this
is in fact a special case 2.5 D object result with many spheres
can rival scenes of ‘real’ ray tracers. E.g. repeat apply on
dragged selections for 200 balls can be done in a matter of 10
minutes, which may well take a full day to compute
otherwise...But rather than trying to outdo 3-D applications, the
idea is to provide a tool for local work within the context of
Photoshop and this is a particularly powerful extension.

KPT Glass Lens Soft

The third decoupled Glass Lens has very soft settings of a low
intensity sun (<15%) and higher Ambiance, creating less hot
spot but more prominent shadows on the sphere. Try it over a
Gradient rainbow sweep with full intensity colors, creating small
‘solid color’ spheres with very subtle hue modulation.

You can of course use all the lenses in odd shaped feathered
selections for non ‘ball’ like effects...

In the future there will be a full Glass Effects filter with a number
of controls. And some exciting surprises!

Noise Menu >

KPT Grime Layer

Seemingly innocuous little thing, tiny and fast. It applies a
special dark transparent noise over the current area, subtly
different from any the normal Noise would produce. It comes in
extremely handy as a quick way to add texture to an area, as a
starting point for scratch textures (e.g. use the smudge filters on
this!) and many other subtle uses. Again: feather, move, copy
and past controls, etc...

A simple example of an implied effect: use Grime on a plain
white background and repeat 4-5 times: the dark regions will
obscure more and more space and choke the white area into a
perfect “star field” background!! It will even create the anti
aliased ‘less than one pixel” stars that are necessary for



realistic screen images. (single pixel dots do NOT look like
stars!) Try that!

KPT Hue Protected Noise Maximum

Another extremely simple tool in your arsenal, yet very very
handy! The built in PS Noise function on an RGB image will
create tri color speckles. Overlaying that one, e.g. a face will
add red green and blue dots on the skintones and ‘ruin’ the look
in the process. This noise will act similarly but exempt the HUE
from the noise computation...so that slight random dither texture
is created in the current selection, but the skin tones in the
example would remain unaffected! In combination with some of
the other smudge, diffuse and scatter tools this is like a new
small brush to paint with. Utterly simple, but you cannot
possibly have too many of these things.

The Maximum setting will create a serious amount of noise at
about 99%. Notice that the apply curve is also a weighted
Gaussian and bright white and black are not affected by the
noise! This extra subtle feature makes all the difference in the
world, where all previous Noise generators would affect both
highlights and background in black with high contrast opposite
colors.

There is a technique involving the splitting of an RGB image into
HSV and then applying regular Noise into just the saturation or
brightness channel, then recombining into RGB. While that
indeed vyields very similar results not only is the direct filter
faster by a factor of 10, it also has the unique advantage of
being a single UNDO event! unlike the multi step approach.
This is not to be taken lightly!

KPT Hue Protected Noise Medium

The Medium setting at about 30% will generate Noise with the
same characteristics as above, but the Gaussian curve is
compensated and the resulting noise will be visible yet not
harsh. Repeat apply for mid way settings between Medium and
Maximum. (In fact the three filters in multiple applies will cover
the entire range)

KPT Hue Protected Noise Minimum



The Minimum setting is at about 3% and is barely visible in most
cases. Alas that is exactly the purpose: an extreme fine control
to just ever so little texturizing... If you take standard blend you
can create tiny micro pertubations with the minimum Noise and
then use Levels or Sharpen or Find Edges to accentuate these
little anomalies. In fact it is such detail work that can bring
natural looking images to computer generated art, taking away
the all too smooth linearity and adding the chaotic fractal like
micro change that Nature so favors. Use it in many different
situations, don’'t give up if you don’t see instant gross effects.
This is a detailer’s tool.

KPT Special Blue Noise

Here we have a trio of decoupled plugins providing unusual
noises: these are actually subscribing to the gradients (the old
Lego block interconnectivity). The gradients used have partial
transparency so that the resulting noise is slightly anti aliased
with an overlay layer on the background. In can serve as a nice
starting point or intermediate stage in building up backgrounds
and textures...



Reminder: be sure to exercise caution if you delete presets in
the Gradient Designer. Other textures, fractals as well as these
Noises may rely on them and will turn black if missing...

KPT Special Green Noise

The gradient used here is strong Green. For the desperate and
would be Power user: you can go in with ResEdit and replace
the gradient subscribed to with any other preset of your own
choice. A full Gradient Noise Designer plugin may come in the
future.

KPT Special Red Noise

The Red Noise is exhibiting quite different properties from the
others. The method of deriving the Noise from the Gradient
presets implies that each one has unique alpha channel opacity
behavior! This is not simply one noise filter with three HUE
settings! Experiment!

Large feathered selections, copied and then paste controlled etc
etc... can yield very new and subtle images. Also try to process
the noises with the smudge and edges filters.

Sharpen Menu >

KPT Sharpen Intensify

This i1s an example of a particular unusual decoupled
momentary filter. It is in fact a Diffuse with apply mode, but set
to a zero Diffuse. No pixels will move at all and the effect is
reduced to an applied intensity Arbitrary Map. The result is a
non linear weighted punch up of the intensity curves, yielding
stronger contrast and brighter colors. This filter will not always
behave the same, e.g. on a new white window you will see
absolutely nothing...(the again you wouldn’'t with “Blur More”
either). try it on a face or flowers or similar strong hue scanned
image. You can do it to just a rectangular portion at a time.
There are limits to the pushing that can reasonable be expected
and with repeated application you may converge on black and
overdriven saturation, but used in controlled dosage the filter is
extremely effective! In its best situations the resulting image will
look so much more vivid that an undo to the previous untreated
version will seem as if it had a drab hazy gauze layer over it!




You may wonder how you ever accepted that before!

Stylize Menu >

Diffuse More KPT

This is a very basic example of a useful extension of an already
useful standard Photoshop tool. Standard Diffuse shuffles the
pixels in a small cell area of less than 25 pixels. This one simply
give you a bigger brush, set to about 4 times the cell size.

Note though that this is not simple saving you three repeats of
the normal diffuse. The way that neighboring cells and pixels are
affected by a diffuse operation will not vary in repeated
application, whereas the larger one does operate on a much
larger set of pixels at once. To learn of the differences and
characteristics of all the new variations you simply will have to
log mileage and try it out...

Find Edges & Invert KPT

We re-engineered the standard Photoshop Find Edges
algorithm (no we did not have any code from Adobe to do that)
and provide here a couple of subtle alternates. A full Edge filter
controller might come as well. The first in the list is an exact
recreation of the original find edges, providing a remedy for one
simple aspect: often times you are after a positive image effect
and after the Find Edges you routinely will run command-i to
invert the image. Nice. Looks cool. trouble is: if you don't like it
and hit UNDO only the second invert step is undone...you
committed to the edge operation. This one is a very simple cure
providing the complementary Find Edges PLUS the Invert in a
single one step filter.

One step as in : undo-able on the fly.

Find Edges Charcoal KPT

Here we have alternate settings in the algorithm itself. This one
will run an inverted image and on a full color RGB scan often
result in faint grayish lines on white wherever the edges pass a
certain threshold. While this can look strikingly like gray
charcoal on white paper and earn its name, do not forget that
these are algorithmic operations processing your existing image
and the result will vary tremendously with different source



material. It would be futile to name the filter across that broad
spectrum and you should merely regard the name as a
mnemonic reminder of the type. You should acquire more
knowledge to its real range and capabilities by applying it to a
variety of images, feather settings, .

Find Edges Soft KPT

The third setting includes a softer algorithm with a low pass and
an invert stage. If you run this one side by side with the original
Find Edges you may suddenly find that one exceedingly harsh
and intense. This one will for instance not create full rectangles
around single bright pixels, but rather smooth edge outlines.
You may come to prefer this by far over the original. Give it a

try.. :)
Scatter Horizontal KPT



An unusual special case filter. this one is a scanline based
horizontal stretcher, doing essentially a non cell line diffusion
and includes a lightening apply mode. This filter really comes
into its own with 4,5,6 repeated applies, stretching a selection
and swallowing certain features while bringing out others. A
unigue streaking trailing effect can result. Its an odd shaped
brush in your palette, but it does have its moments. Kind of a
sand wedge, not a sandwich.

Suggestion to expand the use: you can rotate the window or
selection 90 degrees to get a vertical version (multiple crossed
repeats of both can do neat cloth-like stuff....) or invert the colors
to have a “darken” like effect. Many peculiar combinations with
the other filters are yet to be tried by someone. Be the first one
to discover them!

Video Menu >
KPT Cyclone
This plug-in stands out as a completely unique animal. It may at
first glance appear as a trivial little screen saver light show
thingie, but not so! This is very serious business!
What you are looking at is basically the one of the first 24 bit full
color CLUT animation technologies applied to a very unique
concept.
Normally you achieve Colorization and hue settings by using the
controls in the Levels..., Curves, Arbitrary Map.., Balance and
Hue Dialogs. Each one has a distinctive unique way of
traversing the color space and alter partial aspects of hue,
saturation, intensity etc... While these controls are very
powerful it precludes and even mandates deep knowledge on
the user’s part to achieve repeatable results.
Even given this knowledge, the process of trial and error using
tools in separate dialogs vyields a rather low number of
alternatives in any given time span.
Enter Cyclone!
If you run this filter nothing seems to happen, no dialog is
shown. But slowly you begin to notice the colors mutating and
drifting! And just when you think its a cheap 60s lightshow,
consider what is happening: you are in the process of building a




standard Photoshop Arbitrary Map which can be loaded and
applied to any image.

This is the exact opposite approach to get there though: rather
than cognitive understanding of the underlying principles and
knowledge on the location and use of all the controls, this one
will automatically cycle through endless permutations, yet be
still steerable with ‘meta’ controls like speed and direction of
change...

In other words: your picture will fly through hundreds of
alternative color tables and even though you may not have the
foggiest idea how it did that or how you could do that yourself,
you simply reduce the whole process to an emotional judgment
call: hey, wow, THAT one is really cool. Click, its yours.

This is not to be underestimated in its impact. Even the most
jaded ultra power user will have to concede that at the speed
these things are generated the alternatives visited and the
unigue territory within the color space that is traversed would
take probably a hundred times longer to emulate by hand, In
other words you will see many many color variations that you
just had not seen before or are even likely to have tried! Sure
you KNOW how they COULD have been achieved, but the plain
fact is that you will also have settled in a certain rut, a secure
approach to the tools in order to gain precise control. Upon
investigation of the resulting AroMaps you will find that some of
the settings may look “highly unlikely” or even nonsensical! And
yet, at least in the image given, you KNOW that’'s what you
wanted because you already SAW what it does!

Specifically here is what happens and how to maximize your
use of the Cyclone technology:

First of: you can use it on any color image, and yet the widest
variety may be achieved by starting with a grayscale image
converted to RGB (still looks just like grayscale). Why? because
when the colors are changed, the curves in each channel are
altered and interpolated. However, if you have an image with
solid red areas, these spots will be “empty” in the green and
blue channels and all curve mutations will have no effect there.



Still... try it in a variety of situations, gray and color.

The other suggestion is to put your window in the full screen
mode, the 2nd and 3rd icon at the far bottom of the Photoshop
tools palette, right under the fore/background rectangles. This
will remove any background windows and show your current
window in its most isolated form. The TAB key will toggle the
tools palette itself on - off.

Then simply run Filter > Video > KPT Cyclone and watch the
action.

You have controls over the speed of the changes (arrow right +,
left -), change the direction (“hey that was cool, go back !”) with
the arrow UP key, go from one to the next intermediate
colortable with the arrow DOWN key, change the transition
algorithm 0/1 2/3 4/5 etc are different styles, smooth blending ,
overlay, subtractive/additive, etc...

If you want to halt the action simply keep the spacebar down or
maybe toggle once a second one the arrow UP key.

You then have three choices: you can either accept the current
color look by pressing RETURN. This will create a standard
Photoshop ArbMap and apply it to the current selection.



OR you can just click the mouse and return to Photoshop
without any action at all.

Third choice is to press the “s” key and Save that arbitrary map
automatically.

If you need help press *?’ any time and a banner with the above
options will scroll by

On a technical note: The program will scan a folder called
Cyclone ArbMaps which is imbedded in the “KPT Support Files”
folder, this was copied to the plugins folder when you installed
the KPT filter set.

Whatever files are found inside the Cyclone folder will become
the key frames of solid known color states, from then on
Cyclone will linearly interpolate and fade transit between
random combinations of these maps. With 10 supplied ArbMaps
that will be a nearly endless series of in betweens...

The entire process can be altered by experienced users by
inserting a set of their own ArbMaps.

When you press the ‘s’ key a file called Cyclone Arbmap.n.date
IS created and incremented.

This is very powerful! rather than prompting for a user name to
save, you can continue watching the Cyclone mutations and
press ‘s’ at any interesting junction, spitting out continuous sets
of ArbMaps that can later be loaded via the Image > Map>
Arbitrary map... Open dialog.

Important preview: on the CD ROM will be a scripted slideshow
version of Cyclone, which lets users create slideshow
presentations and insert any standard ArbMaps (including those
now so easily created with this filter!) at designated timeline
points. So at 3.43 seconds image X will look like THIS, ArbMap
27 A very powerful method indeed...To run a similar presentation
via Quicktime or Premiere, at say 1024 size 24 bit images
changing 15 times a second at least would eat HUNDREDS of
megabytes!.

Explore the color space for alternatives, you will be rewarded
with many subtle results!
And do so early in your creation process, this should not be



thought of as a final pass but rather a brush like tool to get going
in the right direction and then modify from there.

Of course you CAN just let your favorite image sit there with
your favorite dozen ArbMaps and play ScreenSaver or crowd
pleaser...pull the keyboard cable out, one mouse click will stop
it.

Note: command-f repeats this filter, which means it repeats
APPLYING the arb map, not running the color cycling... You
need to access it from the Filter > Video . KPT Cyclone menu
again for that.



